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Regulatory Compliance

The CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit is intended for use as a development platform for
hardware or software in a laboratory environment. The board is an open system design, which does
not include a shielded enclosure. This may cause interference to other electrical or electronic
devices in close proximity. In a domestic environment, this product may cause radio interference. In
such cases, you may be required to take adequate preventive measures. In addition, this board
should not be used near any medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default
may affect its performance and cause interference with other apparatus in the immediate vicinity. If
such interference is detected, suitable mitigating measures should be taken.

The PSoC 6 BLE Pioneer Kit contains electrostatic discharge (ESD) sensitive devices.
Electrostatic charges readily accumulate on the human body and any equipment, and

‘Q \ can discharge without detection. Permanent damage may occur on devices subjected
to high-energy discharges. Proper ESD precautions are recommended to avoid
performance degradation or loss of functionality. Store unused PSoC 6 BLE Pioneer kit
in the protective shipping package.

End-of-Life/Product Recycling
K The end-of life for this kit is five years from the date of manufacture mentioned
as bar code on the back of the box. Contact your nearest recycler for
S discarding the kit.

General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that you perform
procedures only at an ESD workstation. If an ESD workstation is unavailable, use appropriate ESD
protection by wearing an anti-static wrist strap attached to a grounded metal object.

Handling Boards

PSoC 6 BLE Pioneer Kit is sensitive to ESD. Hold the board only by its edges. After removing the
board from its box, place it on a grounded, static-free surface. Use a conductive foam pad, if
available. Do not slide the board over any surface.

PSoC® 6 BLE Pioneer Kit Guide, Doc. # 002-17040 Rev. *B 5
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Thank you for your interest in the CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit. The PSoC 6 BLE
Pioneer Kit enables you to evaluate and develop your applications using the PSoC 6 MCU with
Bluetooth Low Energy (BLE) Connectivity (hereafter called “PSoC 6 MCU”).

PSoC 6 MCU is Cypress’ latest, ultra-low-power PSoC specifically designed for wearables and loT
products. PSoC 6 MCU is a true programmable embedded system-on-chip, integrating a 150-MHz

ARM® Cortex®-M4 as the primary application processor, a 100-MHz ARM Cortex®-M0+ that
supports low-power operations, up to 1 MB Flash and 288 KB SRAM, an integrated BLE 4.2 radio,

CapSense® touch-sensing, and programmable analog and digital peripherals that allow higher
flexibility, in-field tuning of the design, and faster time-to-market.

The PSoC 6 BLE Pioneer board offers compatibility with Arduino™ shields. The board features a
PSoC 6 MCU, a 512-Mb NOR flash, onboard programmer/debugger (KitProg2), USB Type-C power
delivery system (EZ-PD™ CCG3), 5-segment CapSense slider, two CapSense buttons, one Cap-
Sense proximity sensing header, an RGB LED, two user LEDs, and one push button. The board
supports operating voltages from 1.8 V to 3.3 V for PSoC 6 MCU.

The CY8CKIT-062-BLE package includes a CY8CKIT-028-EPD E-INK Display Shield that contains
a 2.7-inch E-INK display, a motion sensor, a thermistor, and a PDM microphone. The kit package
also contains a CY5677 CySmart BLE 4.2 USB Dongle that is factory-programmed to emulate a BLE
GAP Central device, enabling you to emulate a BLE host on your computer.

You can use PSoC Creator™ to develop and debug your PSoC 6 MCU projects. PSoC Creator is
Cypress’ standard integrated design environment (IDE). PSoC Creator also supports exporting your
designs to other third party firmware development tools.

If you are new to PSoC 6 MCU and PSoC Creator IDE, you can find introductions in the application
note AN210781 - Getting Started with PSoC 6 MCU with Bluetooth Low Energy (BLE) Connectivity.

1.1 Kit Contents

The CY8CKIT-062-BLE package has the following contents, as shown in Figure 1-1.
PSoC 6 BLE Pioneer Board

CYB8CKIT-028-EPD E-INK Display Shield

CY5677 CySmart BLE 4.2 USB Dongle

USB Type-A to Type-C cable

Four jumper wires (4 inches each)

Two proximity sensor wires (5 inches each)

Quick Start Guide

PSoC® 6 BLE Pioneer Kit Guide, Doc. # 002-17040 Rev. *B 6
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Figure 1-1. Kit Contents
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Inspect the contents of the kit; if you find any part missing, contact your nearest Cypress sales office
for help: www.cypress.com/support.

1.2 Board Details

Figure 1-2 shows the Pioneer board that has the following features:

PSoC 6 MCU with BLE connectivity

Expansion headers that are compatible with Arduino Uno™ 3.3 V shields' and Digilent® Pmod™
modules

512-Mbit external quad-SPI NOR Flash that provides a fast, expandable memory for data and
code

KitProg2 onboard programmer/debugger with mass storage programming, USB to UART/I2C/
SPI bridge functionality, and custom applications support

EZ-PD CCG3 USB Type-C power delivery (PD) system with rechargeable lithium-ion polymer (Li-
Po) battery support?

CapSense touch-sensing slider (5 elements), two buttons, all of which are capable of both self-
capacitance (CSD) and mutual-capacitance (CSX) operation, and a CSD proximity sensor that let
you evaluate Cypress’ fourth-generation CapSense technology

1.8 V to 3.3 V operation of PSoC 6 MCU is supported. An additional 330 mF super-capacitor is
provided for backup domain supply (Vbackup)

Two user LEDs, an RGB LED, a user button, and a reset button for PSoC 6 MCU. Two buttons
and three LEDs for KitProg2

N =

PSoC® 6 BLE Pioneer Kit Guide, Doc. # 002-17040 Rev. *B

5V shields are not supported
Battery and power-delivery capable USB Type-C to Type-C cable are not included in the kit package and should be purchased separately.


www.cypress.com/support

&= CYPRESS

N EMBEDDED IN TOMORROW™

Figure 1-2. Pioneer Board
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1. Battery charging indicator (LED6) 20. KitProg2 programming target selection switch (SW6)?
2. USB PD output voltage availability indicator (LED7) 21. CapSense slider and buttons
3. KitProg2 USB connector (J10) 22. CapSense proximity header (J13)
4. Cypress EZ-PD™ CCG3 Type-C Port Controller 23. PSoC 6 BLE VDD selection switch (SW5)
with PD (CYPD3125-40LQXI, U3) 24. PSoC 6 BLE power monitoring jumper (J8)?
5.  KitProg2 programming mode selection button (SW3) 25. Arduino™ Uno R3 compatible ICSP header (J5)*
6. KitProg2 1/0 header (J6)* 26. PSoC 6 BLE user LEDs (LED8 and LED9)
7. KitProg2 programming/custom application header (J7)* ~ 27. RGB LED (LED5)
8.  External power supply connector (J9) 28. Cypress 512-Mbit serial NOR flash memory (S25FL512S, U4)
9. PSoC 6 BLE user button (SW2) 29. Cypress serial Ferroelectric RAM (U5)*
10. KitProg2 application selection button (SW4) 30. Vbackup and PMIC control selection switch (SW7)
11. Digilent® Pmod™ compatible 1/0 header (J14)* 31. Cypress PSoC 6 BLE (CY8C6347BZI-BLD53, U1)
12. Power LED (LED4) 32. BLE antenna
13. KitProg2 status LEDs (LED1, LED2, and LED3) 33. U.FL connector for external antenna (J17)*
14. PSoC 6 BLE reset button (SW1) 34. Cypress main voltage regulator (MB39C022G, U6)
15. PSoC 6 BLE I/0 header (J18, J19 and J20) 35. KitProg2 (PSoC 5LP) programmer and debugger
16. Arduino™ Uno R3 compatible power header (J1) (CYBC5868LTI-LPO39, U2)
17. PSoC 6 BLE debug and trace header (J12) 36. Battery connector (J15)*2
18. Arduino™ Uno R3 compatible PSoC 6 BLE 37. USB PD output voltage (9V/12V) connector (J16)*
I/0 header (J2, J3 and J4) “Footprints only, not populated on the board
19. PSoC 6 BLE program and debug header (J11) 2Components at the bottom side of the board

PSoC® 6 BLE Pioneer Kit Guide, Doc. # 002-17040 Rev. *B 8
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Table 1-1. Selection Switches in the Pioneer Board

Introduction

Location on the

Switch board

Purpose

Default
Position

SW5 front

Selects the Vpp supply of PSoC 6 MCU between 1.8V,

3.3V, and variable 1.8 V to 3.3 V that is controlled by
KitProg2.

3.3V

SW6 back

In the “PSoC 6 MCU” position:

m KitProg2 can program the onboard
PSoC 6 MCU

m In addition, the PSoC 6 MCU can be pro-
grammed by an external programmer
such as a MiniProg3 connected to J11

Avoid connecting any external devices to J11 in the
“PSoC 6 MCU?” position, as it can cause programming
failure.

In the “External Device” position:

m KitProg2 can program any PSoC 4/5/6
devices connected to J11

PSoC 6 MCU

SW7 back

Selects the Vbackup supply connection of PSoC 6 MCU
between Vppp and the super-capacitor. When Vppp is
selected, the regulator can be turned ON/OFF by the
KitProg2. When the super-capacitor is selected, PSoC 6
MCU can turn the regulator ON/OFF.

Vppp / Kit-
Prog2

PSoC® 6 BLE Pioneer Kit Guide, Doc. # 002-17040 Rev. *B
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Figure 1-3 shows the pinout of the Pioneer board.
Figure 1-3. Pioneer board Pinout
SWDIO P15_4
SWDCLK P1_6 P5LP_VDD— —NC
RESET PO_7 P15_1— —PO_1
GND PO_3 P15_2— —P12_0
P5LP_VDD PO_2 P15_3— —P3_0
P12 5 P12 1
P34 | |-P3.5
P12 7 —P12_6
P3_6—| —GND
P6_0/SCL | T |-P12_4
§ P6_1/SDA — | |-P12.5
\VCC/P6_VDD E VREF/AREF —{ | |-pP12. 6
GND/GND —::— GND
o922 P12 2/D13— | —P12.7
PN P12 1/D12— | P10
B8 P12 0/D11— [ |-p1 2
by P12 3/D10— [ —p1 3
IR P13 1/09 —| | P14
P11_0 P13_0/D8 —_| P15
P11 2 P6_VDD/IOREF
P7_0 RESET/RESET
P7_3 V3.3/3.3V —
P7_4 V5.0/5V PO_2/D7— | P87
P75 GND/GND P5_6/D6— | —P8.6
P76 GND/GND P5_5/D5— | —P8.5
P7_7 VIN/Vin P5_4/D4— | [—P8_4
P5_3/D3—{_| —P8 3
P5_2/D2— | P82
P10_0/A0 —| | P5_1/D1—| [ [~ P8_1
P10_1/A1 — | P5_0/DO—L_L_[—P8_0
P10_2/A2 —|_|
P10_3/A3 —_|
P10_4/A4 —_|
P10_5/A5 —_|
P10_6  —|_|
P62 ] LEGEND
P6_3 1| M Arduino Uno R3
P13_6 1 B PSoC 6 BLE Pioneer Board
W KitProg2 1/0s
g M Digilent Pmod
Table 1-2. Pioneer board Pinout
PSoC6 Primary On-board Seconda . .
. ry . ry . Connection details
Pin Function On-board Function
ANT RFIO, Antenna -
XI ECO IN -
X0 ECO OUT -
XRES Reset -
P0.0 WCO IN -
PSoC® 6 BLE Pioneer Kit Guide, Doc. # 002-17040 Rev. *B 10
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Table 1-2. Pioneer board Pinout (continued)

Introduction

PSoC 6 Primary On-board Secondary . .
Pin Function On-board Function Copiiectonidet B
PO.1 WCO OUT -
P0.2 | Arduino header J4.8, D7 -
P0.3 RGB Red LED -
User Button with
P0.4 Hibernate wakeup -
capability
P0.5 PMIC control -
GPIO on non- Connected to primary and secondary functions by
P1.0 CapSense Tx Arduino header |default. Remove R101 to disconnect from header or
(J19.5) remove R43 to disconnect from CapSense
P1.1 RGB Green LED —
P12 GPIO on non Arduino _
' header (J19.4)
P13 GPIO on non Arduino B
) header (J19.3)
P14 GPIO on non Arduino _
' header (J19.2)
GPIO on non- . .
P15 Orange User LED Arduino header Connected to primary and. secondary function by
(J19.1) default. Remove R13 to disconnect from LED.
Arduino J4.1, DO
P5.0 UART RX - Remove R120 to disconnect from KitProg2 UART TX
KitProg2 UART TX
Arduino J4.2, D1
P5.1 UART TX - Remove R119 to disconnect from KitProg2 UART RX
KitProg2 UART RX
Arduino J4.3, D2 Remove R77 and load R78 to disconnect from Kit-
P5.2 UART RTS - Prog2 UART CTS (This will also disconnect RTS and
KitProg2 UART CTS SPI lines from KitProg2
Arduino J4.4, D3 Remove R77 and load R78 to disconnect from Kit-
P5.3 UART CTS - Prog2 UART CTS (This will also disconnect RTS and
KitProg2 UART RTS SPI lines from KitProg2
P5.4 Arduino J4.5, D4 -
P5.5 Arduino J4.6, D5 -
P5.6 Arduino J4.7, D6 -
Arduino J3.10, SCL . .
P6.0 . - Remove R109 to disconnect from KitProg2 12C SCL
KitProg2 12C SCL
Arduino J3.9, SDA ) .
P6.1 . - Remove R114 to disconnect from KitProg2 12C SDA
KitProg2 12C SDA
GPIO on non Arduino
P6.2 header (J2.15) B

PSoC® 6 BLE Pioneer Kit Guide, Doc. # 002-17040 Rev. *B
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Table 1-2. Pioneer board Pinout (continued)

Introduction

PSoC 6 Primary On-board Secondary . .
Pin Function On-board Function Copiiectonidet B
GPIO on non Arduino Remove R144 to disconnect from GND and populate
P6.3 CapSense Shield |R138 to connect to CapSense shield (hash pattern
header (J2.17)
on board)
P6.4 TDO/SWO -
P6.5 TDI -
P6.6 TMS/SWDIO - Remove R147 to disconnect from KitProg2 SWDIO
P6.7 TCLK/SWCLK - Remove R146 to disconnect from KitProg2 SWCLK
GPIO on non-
P7.0 TRACECLK Arduino header |Populate R135 to connect to J18 header
(J18.6)
P7.1 CINTA -
P7.2 CINTB CSH Remove C88 (0.47nF) and populate 10nF for CSH
P73 GPIO on non Arduino CSH Remove R88 to disconnect from header and popu-
' header (J18.5) late C88 (10nF) for CSH
GPIO on non-
P7.4 TRACEDATA[3] Arduino header |Populate R132 to connect to J18
(J18.4)
GPIO on non-
P7.5 TRACEDATA[2] Arduino header |Populate R133 to connect to J18
(J18.3)
GPIO on non-
P7.6 TRACEDATA[1] Arduino header |Populate R134 to connect to J18
(J18.2)
GPIO on non-
P7.7 CMOD Arduino header |Populate R87 to connect to J18
(J18.1)
GPIO on non- .
P80 Proximity Arduino header Replace R31 with Zero ohm and populate R34 to
connect to header
(J20.1)
GPIO on non- .
P8 1 CapSense Button0 Rx Arduino header Remove R44 to disconnect CapSense pad and pop-
ulate R100 to connect to header
(J20.2)
GPIO on non- .
P82 CapSense Button1 Rx Arduino header Remove R50 to disconnect CapSense pad and pop-
ulate R103 to connect to header
(J20.3)
GPIO on non- .
P8.3 CapSense Silder0 Rx Arduino header Remove R45 to disconnect CapSense pad and pop-
ulate R99 to connect to header
(J20.4)
GPIO on non- .
P8 4 CapSense Silder! Rx Arduino header Remove R46 to disconnect CapSense pad and pop-
ulate R97 to connect to header
(J20.5)
GPIO on non- .
P85 CapSense Silder2 Rx Arduino header Remove R47 to disconnect CapSense pad and pop-
(J20.6) ulate R105 to connect to header

PSoC® 6 BLE Pioneer Kit Guide, Doc. # 002-17040 Rev. *B
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Table 1-2. Pioneer board Pinout (continued)

Introduction

PSoC 6 Primary On-board Secondary . .
Pin Function On-board Function SERMEGIE GEE S
GPIO on non- .
P86 CapSense Silder3 Rx Arduino header Remove R48 to disconnect CapSense pad and pop-
ulate R98 to connect to header
(J20.7)
GPIO on non- .
P87 CapSense Silderd Rx Arduino header Remove R49 to disconnect CapSense pad and pop-
ulate R104 to connect to header
(J20.8)
GPIO on non Arduino
P9.0 header (J2.2) B
PO 1 GPIO on non Arduino _
' header (J2.4)
GPIO on non Arduino
P9.2 header (J2.6) -
GPIO on non-
P9.3 TRACEDATA[0] Arduino header |Populate R131 to connect to header
(J2.8)
GPIO on non Arduino
Po.4 header (J2.10) B
GPIO on non Arduino
P9.5 header (J2.12) B
GPIO on non Arduino
Po.6 header (J2.16) B
GPIO on non Arduino
P9.7 header (J2.18) B
P10.0 Arduino J2.1, A0 -
P10.1 Arduino J2.3, A1 -
P10.2 Arduino J2.5, A2 -
P10.3 Arduino J2.7, A3 -
Arduino J2.9, A4
P10.4 -
PDM_CLK
Arduino J2.11, A5
P10.5 -
PDM_DAT
GPIO on non Arduino
P10.6 header (J2.13) B
GPIO on non- Connected to primary and secondary function by
P11.0 FRAM CS Arduino header |default. Remove R17 to disconnect from J18 and
(J18.8) load R10 (10K) as FRAM pull-up.
P11.1 RGB Blue LED -
GPIO on non-
P11.2 QSPI FLASH CS Arduino header Pppulate R8 to connect to J18, remove R5 and R7 to
disconnect from Flash and pull-up.
(J18.7)
QSPI FLASH/
P11.3 FRAM DATA3 B
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Table 1-2. Pioneer board Pinout (continued)

Introduction

PSoC 6 Primary On-board Secondary . .
Pin Function On-board Function Copiiectonidet B
QSPI FLASH/
P11.4 FRAM DATA2 -
QSPI FLASH/
P11.5 FRAM DATA1 -
QSPI FLASH/
P11.6 FRAM DATAO -
QSPI FLASH/
P11.7 FRAM CLK -
Arduino J3.4. D11 Remove R77 and load R78 to disconnect from Kit-
P12.0 o - Prog2_SPI lines (This will also disconnect RTS and
SPIMOSI CTS lines from KitProg2)
Arduino J3.5. D12 Remove R77 and load R78 to disconnect from Kit-
P12.1 = - Prog2_SPI lines (This will also disconnect RTS and
SPIMISO CTS lines from KitProg3)
Arduino J3.6. D13 Remove R77 and load R78 to disconnect from Kit-
P12.2 ’ - Prog2_SPI lines (This will also disconnect RTS and
SPICLK CTS lines from KitProg4)
Arduino J3.3. D10 Remove R77 and load R78 to disconnect from Kit-
P12.3 = - Prog2_SPI lines (This will also disconnect RTS and
SPISELECT CTS lines from KitProg5)
GPIO on non- Connected to primary and secondary function by
P12.4 | KitProg2 SPI SELECT Arduino header |default. Remove R81 to disconnect from J19 or
(J19.10) remove R84 to disconnect KitProg2_SPI_SELECT
GPIO on non- Connected to primary and secondary function by
P12.5 PMOD SPI SELECT Arduino header |default. Remove R71 to disconnect from J19 or
(J19.9) remove R82 to disconnect PMOD_SPI_SELECT
GPIO on non Arduino
P12.6 header (J19.7) -
GPIO on non Arduino
P12.7 header (J19.5) -
P13.0 Arduino J3.1, D8 -
P13.1 Arduino J3.2, D9 -
GPIO on non Arduino Remove R144 to disconnect from GND and populate
P13.6 CapSense Shield |R137 to connect to CapSense shield (hash pattern
header (J2.19)
on board)
GPIO on non- . .
P13.7 Red User LED Arduino header Connected to primary and. secondary function by
(J2.20) default. Remove R16 to disconnect from LED.
SAR BYPASS, J3.8,
VREF AREF -
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Figure 1-4 shows the E-INK display shield that has the following features:

m A 2.7 inch monochrome E-INK display with a resolution of 264x176. The E-INK display can retain
its contents even in the absence of power, which provides an ultra low-power, “always-on” display
functionality

m A thermistor that allows temperature-compensation of the display as well as general purpose
temperature measurement.

A 3-axis acceleration and 3-axis gyroscopic motion sensor
A PDM microphone for voice input

An 1/O level translator that allows the board to operate at any voltage between 1.8 Vand 1.8 V ~
5V, by providing a constant 3.3 V interface to the E-INK display

m Aload switch that can be controlled by the board to toggle the E-INK display’s power.
Figure 1-4. E-INK Display Shield

CYBCKIT-028-EPD
E-INK DISPLAY SHIELD

EARCODE

ORCODE %
e 1%y 2
’

1. 2.7- inch E-INK display 6. Arduino compatible power and I/0 header (J1)
2. Motion Sensor (U5) 7. E-INK display power control load switch (U3)
3. Thermistor (RT1) 8. E-INK display connector (J5)

4. PDM microphone (U1) 9. E-INK display /0 voltage translator (U2)

5. Arduino compatible
I/0 headers (J2, J3 and J4)
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Figure 1-5 shows the pinout of the E-INK display shield.
Figure 1-5. E-INK Shield Pinout
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) 7 BORDER/D6
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Eeoceceey
NC/5 V HEEE EE INT1/D9
3.3V /3.3V goeeiceiece SSEL/D10
NC/RESET - PR AR MOSI/D11
VIO_REF/ IOREF Ea EE E SRk MISO/D12
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2 GND/GND
NC/VREF
I2C_SDA/SDA
12C_SCL/SCL

LEGEND
Bl Arduino Uno R3
B E-INK Display Shield

30024ve
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Table 1-3. E-INK Shield Pinout

Introduction

Pin # Arduino Pin Arduino Function | E-INK Shield Function | Pioneer Board Connection
J3.1 D8 DIGITAL I/O IMU INT1 P13[0]
J3.2 D9 PWM IMU INT2 P13[1]
J3.3 D10 SS/PWM SSEL P12[3]
J34 D11 MOSI/PWM MOSI P12[0]
J3.5 D12 MISO MISO P12[1]
J3.6 D13 SCK SCLK P12[2]
J3.7 D14 GND GND GND
J3.8 D15 analog ref i/p NC VREF
J3.9 SCL SDA IMU 12C SDA P6[1]
J3.10 SDA SCL IMU 12C SCL P6[0]
J4.1 DO RX NC NC
J4.2 D1 TX NC NC
J4.3 D2 DIGITAL I/O EPD reset P5[2]
J4.4 D3 PWM, I/O BUSY P5[3]
J4.5 D4 DIGITAL I/O EPD enable P5[4]
J4.6 D5 PWM, I/O DISCHARGE P5[5]
J4.7 D6 PWM, I/O BORDER P5[6]
J4.8 D7 DIGITAL I/O EPD 1/O enable PO[2]
J2.1 A0 ADCO THERM VDD P10[0]
J2.2 A1 ADC1 THERM OUT P10[1]
J2.3 A2 ADC2 THERM OUT P10[2]
J2.4 A3 ADC3 THERM GND P10[3]
J2.5 A4 ADC4 PDM CLK P10[4]
J2.6 A5 ADC5 PDM DATA P10[5]
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1.3 PSoC Creator

PSoC Creator is a state-of-the-art, easy-to-use IDE. It uses revolutionary hardware and software co-

de
dri

1.

o ok~ w

sign, powered by a library of fully verified and characterized PSoC Components™ and peripheral
ver libraries (PDL), as shown in Figure 1-6. With PSoC Creator, you can:

Drag and drop Components to build your hardware system design in the main design workspace.
Co-design your application firmware with the PSoC hardware.

Configure Components using configuration tools or PDL.

Explore the library of 100+ Components.

Access Component datasheets.

Export your design to third-party firmware development tools.

Figure 1-6. PSoC Creator Features
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&8 Amplifiers
) ThemalManager h 3 N Reforence ¥ 3 3 & 8 Amp)
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PSoC Creator also enables you to tap into an entire tool ecosystem with integrated compiler chains
and production programmers for PSoC devices.
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1.3.1 PSoC Creator Code Examples

PSoC Creator includes a large number of code examples. These examples are accessible from the
PSoC Creator Start Page, as shown in Figure 1-7 or from the menu File > Code Example.

Code examples can speed up your design process by starting you off with a complete design. The
code examples also show how to use PSoC Creator Components for various applications. Code
examples and documentation are included.

In the Find Code Example dialog, you have several options:

Filter for examples based on device family or keyword.

Select from the list of examples offered based on the Filter Options.

View the project documentation for the selection (on the Documentation tab).

View the code for the selection on the Sample Code tab. You can also copy and paste code from
this window to your project, which can help speed up code development.

m Create a new workspace for the code example or add to your existing workspace. This can speed
up your design process by starting you off with a complete, basic design. You can then adapt that
design to your application.

Figure 1-7. Code Examples in PSoC Creator

Start Page

Learn
Getting Acquainted
MNew in 4.2
News and Information

Start
Create New Project..
Open Existing Project...

Find Code Example ...

= Kits &

1.3.2 Kit Code Examples

You can access the installed kit code examples from the PSoC Creator Start Page. To access these
examples, expand the Kits under the section Examples and Kits; then, expand the specific kit to see
the code examples. For a list of code examples that you can use on this kit, see Code
Examples chapter on page 38.

1.3.3 PSoC Creator Help

Launch PSoC Creator and navigate to the following items:

m Quick Start Guide: Choose Help > Documentation > Quick Start Guide. This guide gives you
the basics for developing PSoC Creator projects.

m Simple Component Code Examples: Choose File > Code Example. These examples demon-
strate how to configure and use PSoC Creator Components. To access examples related to a
specific Component, right-click the Component in the schematic or in the Component Catalog.
Select the Find Code Example option in the context menu that appears.

m System Reference Guide: Choose Help > System Reference Guide. This guide lists and
describes the system functions provided by PSoC Creator.

m Component Datasheets: Right-click a Component and select Open Datasheet.
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1.4 Getting Started

This guide will help you to get acquainted with the PSoC 6 BLE Pioneer Kit:

m The Software Installation chapter on page 23 describes the installation of the kit software. This
includes the PSoC Creator IDE and PDL to develop and debug the applications, the PSoC
Programmer to program the .hex files on to the device, and the CySmart to emulate a host device
in the GAP central role.

m The Kit Operation chapter on page 26 describes the major features of the PSoC 6 BLE Pioneer
Kit and functionalities such as programming, debugging, and the USB-UART and USB-I12C
bridges.

m The Code Examples chapter on page 38 describes multiple PSoC 6 MCU code examples that
will help you understand how to create your own PSoC 6 projects.

m The Appendix on page 41 provides a detailed hardware description, methods to use the onboard
NOR Flash and onboard EZ-PD™ CCG3 Type-C power delivery system, kit schematics, and the
bill of materials (BOM).
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1.5 Additional Learning Resources

Cypress provides a wealth of data at www.cypress.com/psoc6 to help you to select the right PSoC
device for your design and to help you to quickly and effectively integrate the device into your
design.

1.6 Technical Support

For assistance, visit Cypress Support or contact customer support at +1(800) 541-4736 Ext. 2 (in the
USA) or +1 (408) 943-2600 Ext. 2 (International).

You can also use the following support resources if you need quick assistance:
m Self-help (Technical Documents)
m Local Sales Office Locations

1.7 Documentation Conventions

Table 1-4. Document Conventions for Guides

Convention Usage

Displays file locations, user entered text, and source code:
C:\...cd\icc\

Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Creator User Guide.

Courier New

Italics

Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

Represents menu paths:
File > Open > New Project

[Bracketed, Bold]

File > Open

Displays commands, menu paths, and icon names in procedures:

Bold Click the File icon and then click Open.

Times New Roman Displays an equation:

2+2=4
Text in gray boxes Describes cautions or unique functionality of the product.
1.8 Acronyms
Table 1-5. Acronyms Used in this Document
Acronym Definition
ADC Analog-to-Digital Converter
BLE Bluetooth Low Energy
BOM Bill of Materials
CINT Integration Capacitor
CMOD Modulator Capacitor
CPU Central Processing Unit
CSD CapSense Sigma Delta
CTANK Shield Tank Capacitor
DC Direct Current
Del-Sig Delta-Sigma
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Table 1-5. Acronyms Used in this Document (continued)
Acronym Definition
ECO External Crystal Oscillator
EPD Electronic Paper Display
ESD Electrostatic Discharge
F-RAM Ferroelectric Random Access Memory
FPC Flexible Printed Circuit
GPIO General-Purpose Input/Output
HID Human Interface Device
12C Inter-Integrated Circuit
IC Integrated Circuit
ICSP In-Circuit Serial Programming
IDAC Current Digital-to-Analog Converter
IDE Integrated Development Environment
LED Light-emitting Diode
PC Personal Computer
PD Power Delivery
PDM Pulse Density Modulation
PTC Positive Temperature Coefficient
PSoC Programmable System-on-Chip
PWM Pulse Width Modulation
RGB Red Green Blue
SAR Successive Approximation Register
SPI Serial Peripheral Interface
SRAM Serial Random Access Memory
SWD Serial Wire Debug
UART Universal Asynchronous Receiver Transmitter
USB Universal Serial Bus
WCO Watch Crystal Oscillator
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This chapter describes the steps to install the software tools and packages on a PC for using the
PSoC 6 BLE Pioneer Kit. This includes the IDE on which the projects will be built and used for pro-
gramming.

21 Before You Begin

To install Cypress software, you will require administrator privileges. However, they are not required
to run the software that is already installed. Before you install the kit software, close any other
Cypress software that is currently running.

2.2 Install Software

Follow these steps to install the PSoC 6 BLE Pioneer Kit software:

1. Download and run the CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit software from
www.cypress.com/CY8CKIT-062-BLE. The kit software is available in two different formats for
download.

a. CY8CKIT-062-BLE Kit Complete Setup: This installation package contains the files related
to the Kit including PSoC Creator, PSoC Programmer, PDL, and CySmart. However, it does
not include the Windows Installer or Microsoft .NET framework packages. If these packages
are not on your computer, the installer will direct you to download and install them from the
Internet.

b. CY8CKIT-062-BLE Kit Only: This executable file installs only the kit contents, which include
Kit code examples, hardware files, and user documents. This package can be used if all the
software prerequisites (listed in step 5) are installed on your PC.

2. Select the folder in which you want to install the PSoC 6 BLE Pioneer Kit-related files. Choose
the directory and click Next.
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Figure 2-1. Kit Installer Screen

CYRCKIT-062-BLE P52 C & BLE Pieneer Kit - InstallShield Wizard >

Welcome to the InstallShield Wizard for
CY8CKIT-062-BELE P5oC 6 BLE Pioneer Kit

The InstallShield wizard will install Cv8CKIT-062-BLE
PSoC B BLE Pioneer Kit on your computer. To continue,
clich Memt,

Select folder where zetup will inztall files.

G Inztall CvECKIT-062-ELE PSoC &
C:h ACypress Change:...

< Back | Cancel

3. When you click Next, the installer automatically installs the required software, if it is not present
on your computer. Following are the required software:

a. PSoC Creator 4.2: This software is available for download separately at
www.cypress.com/psoccreator. PSoC Creator 4.2 installer automatically installs the following
additional software:

PSoC Programmer 3.27.0
Peripheral Driver Library 2.1.0
Peripheral Driver Library 3.0.1

b. CySmart 1.2 or later, available for download separately at www.cypress.com/cysmart.
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Software Installation

4. Choose the Typical, Custom, or Complete installation type (select Typical if you do not know
which one to select) in the Product Installation Overview window, as shown in Figure 2-2. Click

Next after selecting the installation type.

Figure 2-2. Product Installation Overview

& Cylnstaller for CYBCKIT-062-BLE PSoC & BLE Pioneer Kit

Product Installation Overview
Choose the install type that best suits your needs

Choose the type of installation

Product:
CYBCKIT-062-BLE PSoC 6 BLE Pioneer Kit

Installation Type:

I Typical VI

Installs the most common features of
CYBCKIT-062-BLE PSoC & BLE Pioneer Kit.

Contact Us

MNext = Cancel

5. Read the License agreement and select | accept the terms in the license agreement to con-

tinue with installation. Click Next.

6. When the installation begins, a list of packages appears on the installation page. A green check
mark appears next to each package after successful installation.

7. Enter your contact information or select the check box Continue Without Contact Information.
Click Finish to complete the CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit software installation.

8. After the installation is complete, the kit contents are available at the following location:
<Install Directory>\CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit

Default location:

Windows 7 (64-bit): C:\Program Files

BLE Pioneer Kit

(x86) \Cypress\CY8CKIT-062-BLE PSoC 6

Windows 7 (32-bit): C: \Program Files\Cypress\CY8CKIT-062-BLE PSoC 6 BLE Pio-

neer Kit

Note: For Windows 7/8/8.1/10 users, the installed files and the folder are read-only. To use the
installed code examples, follow the steps outlined in Code Examples chapter on page 38. These
steps will create an editable copy of the example in a path that you choose, so the original installed

example is not modified.
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This chapter introduces you to various features of the PSoC 6 BLE Pioneer Kit, including the theory
of operation and the onboard programming and debugging functionality, KitProg2 USB-UART, USB-
I12C, USB-SPI bridges, and USB Type-C power delivery.

Theory of Operation

The PSoC 6 BLE Pioneer Kit is built around PSoC 6 MCU. Figure 3-1 shows the block diagram of
the PSoC 6 MCU device used in the PSoC 6 BLE Pioneer Kit. For details of device features, see the
device datasheet.

Figure 3-1. PSoC 6 MCU Block Diagram
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Figure 3-2 shows the block diagram for the Pioneer Board.
Figure 3-2. Block Diagram of Pioneer Board
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Kit Operation

The CY8CKIT-062-BLE Pioneer Kit comes with the PSoC 6 BLE Pioneer Board with the
CYB8CKIT-028-EPD E-INK display shield connected, as Figure 3-3 shows.

Figure 3-3. PSoC 6 BLE Pioneer board and E-INK display shield
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Figure 3-4 shows the markup of the Pioneer board.

Figure 3-4. PSoC 6 BLE Pioneer board - Top View
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The PSoC 6 BLE Pioneer board has the following peripherals:

1.

Battery charging indicator (LED7): This LED turns ON when the onboard battery charger is
charging a lithium-iron polymer battery connected to J15. Note that the battery connector and
battery are not included in the Kit and should be purchased separately if you have to test the bat-
tery charging functionality.

USB PD out indicator (LED6): This LED turns ON when the USB Type-C power delivery output
is available for use.

KitProg2 USB connector (J10): The USB cable provided along with the PSoC 6 BLE Pioneer
Kit connects between this USB connector and the PC to use the KitProg2 onboard programmer
and debugger and to provide power to the Pioneer board. J10 is also used for the USB Type-C
power delivery system. See EZPD CCG3 Type-C Power Delivery on page 36 for more details.

Cypress EZ-PD™ CCG3 Type-C Port Controller with PD (CYPD3125-40LQXIT, U3): The Pio-
neer Board includes a Cypress EZ-PD™ CCG3 USB Type-C Port controller with Power Delivery
system. This EZ-PD™ CCG3 device is pre-programmed and can deliver power from a Type-C
port to onboard header J16, while simultaneously charging a lithium-ion polymer battery con-
nected to J15. In addition, the power delivery system can deliver power to a Type-C power sink or
consumer such as a cell phone with the power derived from the VIN supply. See EZPD CCG3
Type-C Power Delivery on page 36 for more details.

KitProg2 programming mode selection button (SW3): This button can be used to switch
between various modes of operation of KitProg2 (Proprietary SWD Programming or Mass Stor-
age programming/CMSIS-DAP mode). This button can also be used to provide input to PSoC
5LP in custom application mode. For more details, see the KitProg2 User Guide.

KitProg2 1/0 header (J6): This header brings out several GPIOs of the onboard KitProg2
PSoC 5LP device. This includes the USB-12C, USB-UART, and USB-SPI bridge lines. The addi-
tional PSoC 5LP pins are direct connections to the internal programmable analog logic of the
PSoC 5LP. You can also use these pins for custom applications. For more details on the Kit-
Prog2, see the KitProg2 User Guide.

KitProg2 programming/custom application header (J7): This header brings out more GPIOs
of the PSoC 5LP, which can be used for custom applications. It also contains a 5-pin SWD pro-
gramming header for the PSoC 5LP.

External Power Supply VIN connector (J9): This connector connects an external DC power
supply input to the onboard regulators and the USB Type-C power delivery system. The voltage
input from the external supply should be between 5V and 12 V. Moreover, when used as an input
to the USB Type-C power delivery system, the external power supply should have enough cur-
rent capacity to support the load connected via the Type-C port. See EZPD CCG3 Type-C Power
Delivery on page 36 for more details.

PSoC 6 MCU user button (SW2): This button can be used to provide an input to PSoC 6 MCU.
Note that by default the button connects the PSoC 6 MCU pin to ground when pressed, so you
need to configure the PSoC 6 MCU pin as a digital input with resistive pull-up for detecting the
button press. This button also provides a wake-up source from low-power modes of the device. In
addition, this button can be used to activate the regulator control output from PSoC 6 MCU.

10.KitProg2 application selection button (SW4): This button can be used to switch between Kit-

Prog2 programming mode and custom application mode. For more details, see the KitProg2 User
Guide.

1. Digilent® Pmod™ compatible I/0O header (J14): This header can be used to connect Digilent®

Pmod™ 1 x 6 pin modules.

12. Power LED (LED4): This is the amber LED that indicates the status of power supplied to PSoC

6 MCU.
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13.

14.

15.

16.

17.

18.

19.

20.

21

22,

23.

24,

25.

26.

27.

28.

29.

Kitprog2 status LEDs (LED1, LED2, and LED3): Amber, Red, and Green LEDs (LED1, LED2,
and LED3 respectively) indicate the status of KitProg2. For details on the KitProg2 status, see
the KitProg2 User Guide.

PSoC 6 MCU reset button (SW1): This button is used to reset PSoC 6 MCU. This button con-
nects the PSoC 6 MCU reset (XRES) pin to ground.

PSoC 6 MCU 1/0 headers (J18, J19, and J20): These headers provide connectivity to PSoC 6
MCU GPIOs that are not connected to the Arduino compatible headers. Majority of these pins

are multiplexed with onbroad peripherals and are not connected to PSoC 6 MCU by default. For
the detailed information on how to rework the kit to access these pins, see Table 1-2 on page 10.

Arduino compatible power header (J1): The Arduino-compatible power header powers Ardu-
ino shields. This header also has a provision to power the kit though the VIN input.

PSoC 6 MCU debug and trace header (J12): This header can be connected to an Embedded
Trace Macrocell (ETM) compatible programmer/debugger

Arduino Uno R3 compatible I/O headers (J2, J3, and J4): The Arduino-compatible I/O head-
ers bring out pins from PSoC 6 MCU to interface with the Arduino shields. Few of these pins are
multiplexed with onboard peripherals and are not connected to PSoC 6 MCU by default. For a
detailed information on how to rework the kit to access these pins, see Table 1-2 on page 10

PSoC 6 MCU program and debug header (J11): This 10-pin header allows you to program and
debug the PSoC 6 MCU using an external programmer such as MiniProg3. In addition, an exter-
nal PSoC 4/5/6 device can be connected to this header and programmed using KitProg2. To
program the external device, SW6 should be used to select the “External” option.

Kitprog2 programming target selection switch (SW6, on the bottom side of the Board):
This switch selects the programming target of the onboard KitProg2 between the onboard PSoC
6 MCU and an external PSoC 4/5/6 device connected to J11.

. CapSense slider (SLIDER) and buttons (BTNO and BTN1): CapSense touch-sensing slider

and two buttons, all of which are capable of both self-capacitance (CSD) and mutual-capaci-
tance (CSX) operation, let you evaluate Cypress’ fourth-generation CapSense technology. The
slider and the buttons have a 1-mm acrylic overlay for smooth touch sensing.

CapSense proximity header (J13): A wire can be connected to this header to evaluate the
proximity sensing feature of CapSense.

System Power Vpp selection switch (SW5): This switch is used to select the PSoC 6 MCU’s
Vpp supply voltage between constant 1.8 V, constant 3.3 V, and variable 1.8 to 3.3 V. In the vari-
able 1.8 to 3.3 V mode, the PSoC programmer software can control the voltage via the KitProg2.
PSoC 6 MCU current measurement jumper (J8, on the bottom side of the Board): An

ammeter can be connected to this jumper to measure the current consumed by the
PSoC 6 MCU.

Arduino compatible ICSP header (J5): This header provides an SPI interface for Arduino ICSP
compatible shields.

PSoC 6 MCU user LEDs (LED8 and LED9): These two user LEDs can operate at the entire
operating voltage range of PSoC 6 MCU. The LEDs are active LOW, so the pins must be driven
to ground to turn ON the LEDs.

RGB LED (LEDS5): This onboard RGB LED can be controlled by the PSoC 6 MCU. The LEDs
are active LOW, so the pins must be driven to ground to turn ON the LEDs.

Cypress 512-Mbit serial NOR flash memory (S25FL512SAGMFI011, U4): This kit features a
Cypress NOR flash (S25FL512SAGMFI1011) of 512 Mb capacity. The NOR Flash is connected to
the serial memory interface (SMIF) of the PSoC 6 MCU. The NOR device can be used for both
data and code memory with execute-in-place (XIP) support and encryption.

Cypress 4-Mbit serial Ferroelectric RAM (FM25V10, U5): Footprint to connect a FM25V10 or
any other pin compatible FRAM.
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30.

31.

32,
33.

34.

35.

36.

37.

Vbackup and PMIC control selection switch (SW7, on the bottom side of the Board): This
switches the Vbackup supply connection to PSoC 6 MCU between Vppp and the super-capaci-
tor. When Vppp is selected, the regulator ON/OFF is controlled by the KitProg2. When super-
capacitor is selected, the regulator ON/OFF is controlled by PSoC 6 MCU.

Cypress PSoC 6 MCU (CY8C637BZI-BLD74, U1): This kit is designed to highlight the features
of the PSoC 6 MCU. For details on PSoC 6 MCU pin mapping, see Table 1-2 on page 10.

BLE antenna: This is the onboard wiggle antenna for BLE.

U.FL connector (J17): This connector can be used for conductive measurements and also to
connect external antenna.

Cypress main voltage regulator (MB39C022GPN-G-ERE1, U6): This is the main regulator that
powers PSoC 6 MCU. This regulator has two output channels. One channel provides fixed LDO-
based 3.3 V output from 5 V input and the other channel is a buck DC to DC converter that is
configured to provide variable voltage from 1.8 V t0 3.3 V.

KitProg2 (PSoC 5LP) programmer and debugger (CY8C5868LTI-LP039, U2): The PSoC 5LP
device (CY8C5868LTI-LP039) serving as KitProg2, is a multi-functional system, which includes
a programmer, debugger, USB-12C bridge, USB-UART bridge, and a USB-SPI bridge. KitProg2
also supports custom applications. For more details, see the KitProg2 User Guide.

Battery connector (J15, on the bottom side of the Board): This connector can be used to
connect a lithium-ion polymer battery. Note that a battery is not included in the kit package and
should be purchased separately if you want to demonstrate battery charging.

USB PD output (J16): This header provides a voltage output when the USB Type-C power
delivery system receives power from an external host connected to J10. See EZPD CCG3 Type-
C Power Delivery on page 36 for more details.

See Hardware Functional Description chapter on page 41 for details on various hardware blocks.
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3.1.1 CYB8CKIT-028-EPD E-INK Display Shield
Figure 3-5. E-INK Display Shield
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The E-INK display shield has the following peripherals:

1. 2.7 inch E-INK display: This is a monochrome E-INK display with a resolution of 264x176. The
E-INK display can retain its contents even in the absence of power, which provides a low-power,
“always-on” display functionality.

2. Motion sensor (U5): This is a 3-axis acceleration and 3-axis gyroscopic motion sensor that can
be used to count steps to emulate a pedometer or similar application.

3. Thermistor(RT1): This thermistor can be used for temperature compensation of the display or as
a general purpose ambient temperature sensor.

4. PDM microphone (U1): This microphone converts voice inputs to Pulse-Density Modulated
(PDM) digital signals.

5. Arduino compatible 1/0 header (J2, J3 and J4): This header interfaces with the PSoC 6 MCU
GPIOs through header J2 on the board.

6. Arduino compatible power & 1/0 header (J1): This header receives power from header J1 on
the board.

7. E-INK display power control load switch (U3): This load switch can be controlled by the board
to toggle the E-INK display’s power.

8. E-INK display connector (J5): This connector is used to connect the E-INK display to the cir-
cuits on the E-INK display shield.

9. E-INK display I/O voltage translator (U2): This I/O level translator allows the board to operate
at any voltage between 1.8 and 3.3 V by providing a constant 3.3 V interface to the E-INK display.
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3.2 KitProg2

The PSoC 6 BLE Pioneer Kit can be programmed and debugged using the onboard KitProg2. The
KitProg2 is a multi-functional system, which includes a programmer, debugger, USB-I12C bridge,
USB-UART bridge, and a USB-SPI bridge. KitProg2 also supports mass storage programming and
CMSIS-DAP, and custom applications. A Cypress PSoC 5LP device is used to implement KitProg2
functionality. The KitProg2 is integrated in most PSoC development kits. For more details on the Kit-
Prog2 functionality, see the KitProg2 User Guide.

Before programming the device, ensure that PSoC Creator and PSoC Programmer software are
installed on the computer. See the Install Software chapter on page 23 for more information.

3.2.1 Programming and Debugging using PSoC Creator

1. Connect the PSoC 6 BLE Pioneer Kit to the PC using the USB cable, as shown in Figure 3-6.
The kit enumerates as a composite device if you are connecting it to your PC for the first time.
The successful enumeration is indicated by the following status LEDs: Amber LED ON, Green
LED OFF, and Red LED OFF. If you do not see the desired LED status, see the KitProg2 User
Guide for details on the KitProg2 status and troubleshooting instructions. For example, if the
Amber LED is showing a breathing effect, press the mode button to switch from mass storage
programming mode to SWD programming mode.

Figure 3-6. Connect USB Cable to USB connector on the kit

CYBCKIT-028-EPD
E-INK DISPLAY SHIELD

2. Open the desired project in PSoC Creator. For this, go to File > Open > Project/Workspace.
This provides the option to browse and open your saved project.

3. Select the option Build > Build Project or pressing [Shift] [F6] to build the project.
4. If there are no errors during build, select Debug > Program or press [Ctrl] [F5]. This programs
the device on the PSoC 6 BLE Pioneer Kit.

PSoC Creator has an integrated debugger. You can start the debugger by selecting Debug > Debug
or by pressing [F5]. For a detailed explanation on how to debug using PSoC Creator, see the
Debugging Using PSoC Creator section in the KitProg2 User Guide
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3.2.2 Programming using PSoC Programmer

PSoC Programmer can be used to program existing .hex files into the PSoC 6 BLE Pioneer Kit. For
a detailed explanation on how to program using PSoC Programmer, see the Programming Using
PSoC Programmer section in the KitProg2 User Guide.

The KitProg2 firmware normally does not require any update. If necessary you can use the PSoC
Programmer software to update the KitProg2 firmware. For a detailed explanation on how to update
the KitProg2 firmware, see the Updating the KitProg2 Firmware section in the KitProg2 User
Guide.

3.2.3 Mass Storage Programmer

The KitProg2 in the PSoC 6 BLE Pioneer Kit supports programming through a USB Mass Storage
interface. This interface allows you to program PSoC 6 MCU by copying .hex files into an emulated
USB Mass Storage device. The user can press the mode button to switch to mass storage mode. At
that time, the Amber LED will show a breathing effect. Press the mode button again to switch to the
normal programming mode. For more details on KitProg2 Mass Storage Programmer, see the Kit-
Prog2 User Guide.

3.24 USB-UART Bridge

The KitProg2 on the PSoC 6 BLE Pioneer Kit can act as a USB-UART bridge. The UART and flow-
control lines between the PSoC 6 MCU and the KitProg2 are hard-wired on the board, as Figure 3-7
shows. For more details on the KitProg2 USB-UART functionality, see the KitProg2 User Guide.

Figure 3-7. UART connection between KitProg2 and PSoC 6
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3.2.5 USB-12C Bridge

The KitProg2 can function as a USB-I2C bridge and communicate with the Bridge Control Panel
(BCP) software. The 12C lines on the PSoC 6 MCU are hard-wired on the board to the 12C lines of
the KitProg2, with onboard pull-up resistors as Figure 3-8 shows. The USB-12C supports 12C speeds
of 50 kHz, 100 kHz, 400 kHz, and 1 MHz. For more details on the KitProg2 USB-12C functionality,
see the KitProg2 User Guide.

Figure 3-8. 12C connection between KitProg2 and PSoC 6
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3.2.6 USB-SPI Bridge

The KitProg2 can function as a USB-SPI bridge. The SPI lines between the PSoC 6 MCU and the
KitProg2 are hard-wired on the board, as Figure 3-9 shows. For more details on the KitProg2 USB-

SPI functionality, see the KitProg2 User Guide.
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Figure 3-9. SPI connection between KitProg2 and PSoC 6
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3.3 EZPD CCG3 Type-C Power Delivery

The Pioneer board includes a Cypress EZ-PD CCG3 power delivery system. This EZ-PD™ CCG3 is
pre-programmed and can deliver power from a Type-C port to onboard header J16 (known as the
consumer path), while simultaneously charging a 3.7 V, lithium-ion polymer battery connected to
J15. In addition, the power delivery system can deliver power to a Type-C peripheral such as a cell
phone with the power derived from the VIN (J9) supply (known as the provider path). Note that to
use the EZ-PD™ CCG3 Type-C power delivery system, a power delivery capable USB Type-C to
Type-C cable should be connected to J10. This cable is not included in the kit, and should be pur-

chased separately.

Figure 3-10. Type-C Block Diagram
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The power delivery system works as follows:

1. If the power delivery system detects a non Type-C power adapter (Legacy USB), CCG3 will
charge the battery at 100 mA. CCG3 will also disable the consumer and provider paths.

2. On detection of a Type-C power adapter, CCG3 will request 5V at3A,9Vat3A,or12Vat3A
depending on the host capability. Once the power level is successfully negotiated, the Consumer
path is enabled by turning on load switch U12. This load switch is hardware limited to supply up
to 1 A through header J16 to an external device. CCG3 will use the remaining current to charge
the battery connected to J15 at a higher charging rate up to 1.5 A and PD output voltage avail-
ability indicator (LED6) will be turned ON.

3. CCG3 will also advertise that it can provide 5V, 9V, or 12 V if a DC power supply capable of pro-
viding either of these voltages is connected at VIN (J9). The current is limited in this case to 1 A.
Note that the external supply must be capable of providing this current. If a connected, Type-C
device requests power, the provider path is enabled by turning on load switch U22. Table below
details the Power delivery scenarios for onboard CCG3.

Table 3-1. Type-C table Power delivery Scenarios

USB Host / consumer VIN Consumer | Provider | External USB PD | Battery Charging
capability capability | capability | out (J16 header) current
Non Type-C Power
adapter (Legacy USB) <oV N/A 0 0 100mA
>5V N/A 0 0 0
Type-C, PD power .
adapter (12V capable) <12V 12V@3A 0 12V@1A 1.5A max
>12V N/A 0 0 0
Type-C, capable of
providing max 9V <9V IWV@3A 0 IW@1A 1.5A max
>9V N/A 0 0 0
Type-C only, capable of
providing max 5V <5 5V@3A 0 5V@1A 1.5A max
>5 N/A 0 0 0
Type-C, requesting 12V #12V 0 5V@1A 0 0
12v 0 12V@1A 0 0
Type-C, requesting 9V #9V 0 5V@1A 0 0
WV 0 IV@1A 0 0
Type-C, requesting 5V #5V 0 5V@1A 0 0
5V 0 5V@1A 0 0
Type-C, requesting 5V <VIN
another voltage <12V 0 SV@1A 0 0

* Due to the voltage drop in series components, the voltage at J16 is ~9 V when 12 V PD power
adapter is used. Populate R79 resistor to bypass this drop.

For more information on USB Type-C power delivery with CCG3 device, see the EZ-PD CCG3 web
page.
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The PSoC 6 BLE Pioneer Kit includes three code examples. To access the code examples, down-
load and install the PSoC 6 BLE Pioneer Kit setup file from www.cypress.com/CY8CKIT-062-BLE.
After installation, the code examples will be available from Start > Kits on the PSoC Creator Start
Page.

4.1 Using the Kit Code Examples

Follow these steps to open and use the code examples.

1. Launch PSoC Creator from Start > All Programs > Cypress > PSoC Creator <version> >
PSoC Creator <version>.

2. On the Start Page, click CY8CKIT-062-BLE under Start > Kits. A list of code examples appears,
as shown in Figure 4-1.

3. Click the desired code example, select a location to save the project, and click OK.

Figure 4-1. Open Code Example from PSoC Creator
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MNew in 4.2
MNews and Information
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Create New Project...

Open Existing Project...

Find Code Example ...
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CE218133_EINK_CapSense.cywrk
CE218135_BLE_Proximity.cywrk
CE219517_KitProg2_Power_Monitoring...
CE220167_BLE_ULcywrk
CE220186_RTC_CTS.cywrk
CE220272_BLE_Direct_Test_Mode.cywrk
CE220235_BLE_Eddystone.cywrk

4. Build the code example by choosing Build > Build <Project Name>. After the build process is
successful, a .hex file is generated.

5. Connect PSoC 6 BLE Pioneer Kit to the PC using the USB cable, as shown in Figure 3-6, to pro-
gram the kit with the code example.

6. Choose Debug > Program in PSoC Creator.
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7. If the device is already acquired, programming will complete automatically — the result will appear
in the PSoC Creator status bar at the bottom left side of the screen. If the device is yet to be
acquired, the Select Debug Target window will appear. Select KitProg2/<serial_number> and
click Port Acquire, as shown in Figure 4-2.

Figure 4-2. Port Acquire

Select Debug Targe'

KitProg2/20140276001C6400 KitProg2/20140276001C6400
- POWER =3
VOLTAGE_ADC = 3301
FREQUENCY = 2000000
PROTOCOL = SWD

KitProg2 Version 1.04 [HW
Rev.0x02]

Show all targets V] l Port Setting ” PortAcquire]

QK /Connect

8. After the device is acquired, it is shown in a tree structure below the KitProg2/<serial_number>.
Click Connect and then OK to exit the window and start programming, as shown in Figure 4-3.
Note: PSoC 6 MCUs have both an ARM Cortex MO+ and ARM Cortex M4 CPUs. To program,
you can select any one of them and click Connect. To debug, you have to select the CPU which
you want to be debugged.

Figure 4-3. Connect Device from PSoC Creator and Program

=5 KitProg2/20140276001C6400 PSoC 63 CY8C6347BZ1-BLD53

L@ PSoC 63 CYBC6347BZ1-BLDS3 (CMOp) gﬁgﬁﬁ%ﬁgﬁg&?“@“ﬂ

» PSoC 63 CY8C6347BZI-BLD53 (CM4) Cypress ID: (xE2072100
Revision: PRODUCTION

Select Debug Target

Target unacquired

Show all targets >

QK / Connect

=

9. After programming is successful, the code example is ready to use.
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4.2 Code Examples

Code Examples

Table 4-1 shows a list of code examples that can be used with this kit. See the individual code
example document for additional details on a particular example.

Table 4-1. Code Examples in PSoC Creator

# Project

Description

1 |CE218133_EINK CapSense

This code example shows how to create a user interface
solution using an E-INK display and CapSense.

2 |CE218135_BLE_Proximity

This code example demonstrates connectivity between
PSoC 6 MCU with BLE and CySmart BLE host emulation
tool or mobile device running the CySmart mobile applica-
tion, to transfer CapSense proximity sensing information.

3 |CE219517_KitProg2_Power_Monitoring

This code example demonstrates how to create a bootload-
able PSoC 5LP (KitProg2) project to monitor the power
consumed by the PSoC 6 MCU device on CY8CKIT-062-
BLE PSoC 6 BLE Pioneer Kit.

4 |CE220167_BLE_UI

This code example demonstrates interfacing PSoC 6 MCU
with user interface functions such as an E-INK display,
RGB LED, and touch sensors based on self and mutual
capacitance (CapSense CSD and CSX) with bi-directional
BLE connectivity between the PSoC 6 MCU device and a
PC running the CySmart BLE Host Emulation tool or a
mobile device running the CySmart mobile application.

5 |[CE220186_RTC_CTS

This code example demonstrates accurate time keeping
with PSoC 6 MCU'’s real time clock (RTC), which is syn-
chronized with a current time server such as an iPhone
using the BLE current time service (CTS).

6 |CE220272_ BLE_Direct_Test_Mode

This code example demonstrates Direct Test Mode (DTM)
over the Host Controller Interface (HCI) using PSoC 6 MCU
with BLE Connectivity.

7 |CE220335_BLE_Eddystone

This code example demonstrates a BLE beacon that broad-
casts the core frame types (UID, URL, and TLM) of Goo-
gle’s Eddystone beacon profile.
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A1 Schematics

Refer to the schematics files available in the kit installation directory under following paths:
1. <Install Directory>\CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit)\
1.0\Hardware\CY8CKIT-028-EPD\CY8CKIT-028-EPD Schematic.pdf

2.<Install Directory>\CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit\
1.0\Hardware\CY8CKIT-062-BLE\CY8CKIT-062-BLE Schematic.pdf

A.2 Hardware Functional Description

This section explains in detail the individual hardware blocks of the PSoC 6 BLE Pioneer board.

A21  PSoC6MCU (U1)

PSoC 6 MCU is Cypress’ latest, ultra-low-power PSoC specifically designed for wearables and loT
products. PSoC 6 MCU is a true programmable embedded system-on-chip, integrating a 150-MHz

ARM® Cortex®-M4 as the primary application processor, a 100-MHz ARM Cortex®-M0+ that
supports low-power operations, up to 1 MB Flash and 288 KB SRAM, an integrated BLE 4.2 radio,
CapSense touch-sensing, and custom analog and digital peripheral functions. The programmable
analog and digital peripheral functions allow higher flexibility, in-field tuning of the design, and faster
time-to-market.

For more information, see the PSoC 6 MCU web page and the datasheet.

A2.2  PSoC 5LP (U2)

An onboard PSoC 5LP (CY8C5868LTI-LP039) is used as KitProg2 to program and debug PSoC 6
MCU. The PSoC 5LP connects to the USB port of a PC through a USB connector and to the SWD
and other communication interfaces of PSoC 6 MCU. The PSoC 5LP is a true system-level solution
providing MCU, memory, analog, and digital peripheral functions in a single chip. The CY8C58LPxx
family offers a modern method of signal acquisition, signal processing, and control with high accu-
racy, high bandwidth, and high flexibility. Analog capability spans the range from thermocouples
(near DC voltages) to ultrasonic signals.

For more information, visit the PSoC 5LP web page. Also, see the CY8C58LPxx Family Datasheet.
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A.2.3 Serial Interconnection between PSoC 5LP and PSoC 6 MCU

In addition of use as an onboard programmer, the PSoC 5LP functions as an interface for the USB-
UART, USB-12C, and USB-SPI bridges, as shown in Figure A-1. The USB-Serial pins of the
PSoC 5LP are hard-wired to the I2C/UART/SPI pins of the PSoC 6 MCU. These pins are also avail-
able on the Arduino-compatible I/O headers; therefore, the PSoC 5LP can be used to control Ardu-
ino shields with an I2C/UART/SPI interface.

Figure A-1. Schematics of Programming and Serial Interface Connections
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EZ-PD CCG3 Power Delivery System

Cypress EZ-PD CCG3 provides a complete solution ideal for power adapters, power banks, Type-C
dongles, monitors, docks and notebooks. See “EZPD CCG3 Type-C Power Delivery” on page 36 for
more details of the power delivery system implementation in the Pioneer board.

Figure A-2. Schematics of EZ-PD CCG3 Power Delivery System

Appendix

CCG3, USB Type-C and Power Delivery

VBUS_TC CCG_VSYS CCG_VBUS OUT
R11 Oohm CCG_VDD cCG veeD
MV No Load
cr
0.1uF Sho
3
o >%§Zr P0.0 gzgoazaan 39 USB_TC_PWR_SENSE
g 2Zz>=00 106 _TC_| S
Xx—p01 B5238723 e Eé&ccw
Q75> ®@> cc2 Cc2
1USB1<—g— P1.0 >
:ngé« P1.1 21
10 P1.2 DPLUS [727—X
CEL §§ P1.3 DMINUS X
P1.4 2
P1v5 VBUS_P_CTRLO [-——>pVBUS_P_CTRLO
>ﬁr P1.6 VBUS_P_CTRL1 [3g—QVBUS_P_CTRL1
X—— P1.7 VBUS_C_CTRLO [pg—20VBUS_C_CTRLO
CCGLED & VBUS_C_CTRL1 WBUS_C_CTRL1
——ar P3.2
CCG_12V_EN K——r— P33 VBUS_DISCHARGE >)VBUS_DISCHARGE
12C_SDA E P3.4
|2c SCL E 8 P3.5 sres F2 CCG XRES L
P3.6 N cag
CCG_SWDIO Lo
WDCLK P2.0 vss 0.1uF
P2.1 EPAD 50V
VBUS_TC_MON ¥ 277| P24
VINMON 25| P25

CYPD3125-40LQXES

VBUS and VIN voltage monitoring

VIN VBUS_TC
R19 I R21
120K 120K

S

VIN_MO| VBUS_TC_MON
R18 c13 R20 cis
75K @ 0AuF—— 75K 0.1UF
50V 50V
A4 A4

Output Indication

CCG_LED << LED/7/ GREEN LED

CCG_VSYS

R2
N 7500hm

CCG Provider path ORing

No Load

CCG_vBUS_OUT

R11 001R

CCG 12V @1A Output

" o |
c98
22uF;
ZSVJ;

A
USB_TC_PWR_SENSE

PSoC® 6 BLE Pioneer Kit Guide, Doc. # 002-17040 Rev. *B

VIN 5V_ouT CCG_VBUS_OUT CCG_VBUS_IN
s uiz J16
C51 C46
1uF 10nF e Ve o7
7 !
25V 50V 5 Vs 3
Vs_4
ekl N 2 ST OSTVNO2A150
CCG_O_EN >>-1—7 N 2
3 |7 S No Load
5 [ BTS4175SGA
iLim GND A
EPAD R66
SiP32429 10K
1500hm|
1%
VBUS Provider/Consumer Path
VBUS_TC CCG_VBUS_IN
R79 Oohm
No Load 1w
cesj_o cse mim ‘°_“"J "’rq ~Fl cat cs3
0.1uF 1uF | 0.1uF! = B EH =—0.1uF 4.7uF
50V 50V 50V 50V 25v
b — ke —
o ~  AO483
R10; R107 R106 R108
0ohm. R64 0ohm 0ohm 0Oohm
2000hm No Load
1%
w R114_._10M] R11Q . 10M,
N
R93 VBUS_DISCHARGE R112
0ohm 0oohm
VBUS_P_CTRLO VBUS_P_CTRL1 VBUS_C_CTRLO VBUS_C_CTRL1

43



- |
e
b

A25

CYPRESS Appeni

EMBEDDED IN TOMORROW™

Power Supply System

The power supply system on this board is versatile, allowing the input supply to come from the fol-
lowing sources:

m 5V,9V, or 12V from the onboard USB Type-C connector

m 5V to 12V power from an Arduino shield or from external power supply through VIN header J9
orJ1

m 3.7V from a rechargeable Li-Po battery connected to J15
m 5V from an external programmer/debugger connected to J11 and J12

The power supply system is designed to support 1.8 V to 3.3 V operation of the PSoC 6 MCU. In
addition, an intermediate voltage of 5 V is required for the operation of the power delivery circuitry
and KitProg2. Therefore, three regulators are used to achieve 1.8 to 3.3 V and 5 V outputs - a buck
boost regulator (U21) that generates a fixed 5 V from an input of 5 to 12 V, and a main regulator (U6)
that generates a variable 1.8 V to 3.3 V and a fixed 3.3 V from the output of U21. Figure A-3 shows
the schematics of the voltage regulator and power selection circuits. In addition to this, the battery
charger U14 also functions as a boost regulator. U14 boosts the battery voltage to provide a 5 V to
the main regulator U6. This feature is enabled only when the VIN and the USB supply are unavail-
able.

The voltage selection is made through switch SW5. In addition, an onboard 330 mF super-capacitor
(C52) can be used to power the backup domain power (Vbackup) of PSoC 6 MCU. Switch SW7
selects the Vbackup supply connection of PSoC 6 MCU between Vppp and the super-capacitor.
When Vppp is selected, the variable regulator ON/OFF terminal is controlled by KitProg2. When the
super-capacitor is selected, the regulator ON/OFF terminal is controlled by PSoC 6 MCU. To ensure
proper operation of PSoC 6 MCU, the super-capacitor, when selected, must be charged internally by
PSoC 6 MCU before turning OFF the regulator. For more details of the PSoC 6 MCU backup system
and power supply, see the PSoC 6 BLE Technical Reference Manual.
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Table A-1 details the different powering scenarios for Pioneer board.

Table A-1. Power supply scenarios

Power inputs Board condition
JTAG/SWD Main PSoC
uUsSB VIN :E\',I'Tl\:ggatliﬁ; Cc?:l:teecrtye d header Regulator | Powered cﬁ::tei;y
— (VTARG_REF)| Powered by | by ging
Non Type-C
power Main
adapter <5 N/A Yes N/A Type-C 100mA
Regulator
(Legacy
USB), 5V
>5 N/A N/A N/A VIN Main No
Regulator
Type-C, PD .
power < PD power N/A Yes N/A Type-C Main 1.5A
adapter Regulator
adapter
> PD power Main
adapter, N/A N/A N/A VIN Requlator No
<12V g
oV 5V-12V N/A N/A N/A VIN Main No
Regulator
ETM Main
ov ov v NA N/A (VTARG_IN) | Regulator |~ "\©
oV oV oV 3.2V-4.2V N/A Battery Main No
Regulator
JTAG/
SWD
ov ov ov ov 1.8V-3.3V N/A (VTARG_ No
REF)
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Figure A-3. Schematics of Power Supply System
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A.2.6 Expansion Connectors

A.2.6.1  Arduino-compatible Headers (J1, J2, J3, J4, and J5)

The board has five Arduino-compatible headers: J1, J2, J3, J4, and J5 (J5 is not populated by
default). You can connect 3.3 V Arduino-compatible shields to develop applications based on the
shield’s hardware. Note that 5 V shields are not supported and connecting a 5 V shield may perma-
nently damage the board. See Appendix A.3 for details on PSoC 6 MCU pin mapping to these head-
ers.

A.2.6.2 PSoC 6 MCU I/O Headers (J18, J19, and J20)

These headers provide connectivity to PSoC 6 MCU GPIOs that are not connected to the Arduino
compatible headers. Majority of these pins are multiplexed with onboard peripherals and are not
connected to PSoC 6 MCU by default. For the detailed information on how to rework the kit to
access these pins, see “PSoC 6 BLE Pioneer Board Reworks” on page 50.

A.2.6.3 PSoC 5LP GPIO Header (J6)

J6 is a 8x2 header provided on the board to bring out several pins of the PSoC 5LP to support
advanced features such as a low-speed oscilloscope and a low-speed digital logic analyzer. This
header also contains the USB-UART, USB-12C, and USB-SPI bridge pins that can be used when
these pins are not accessible on the Arduino headers because a shield is connected. The additional
PSoC 5LP pins are connected directly to the internal programmable analog logic of PSoC 5LP. This
header also has GPIOs for custom application usage. J6 is not populated by default. Note that the
SPI, RTS, and CTS lines on these headers are directly from PSoC 5LP (before level translator).

A.2.6.4  KitProg2 Custom Application Header (J7)

A 5x2 header is provided on the board to bring out more GPIOs of PSoC 5LP for custom application
usage. This header also brings out the PSoC 5LP programming pins and can be programmed using
MiniProg3 and 5-pin programming connector. J7 is not populated by default.
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A.2.7 CapSense Circuit

A CapSense slider, two buttons, all of which support both self-capacitance (CSD) and mutual-capac-
itance (CSX) sensing, and a CSD proximity sensor (header) are connected to PSoC 6 MCU as
Figure A-4 shows. Four external capacitors - Cy;op and Cgp for CSD, Cjnta and Ciytg for CSX are
present on the Pioneer board. Note that CSH is not loaded by default. For details on using Cap-
Sense including design guidelines, see the Getting Started with CapSense Design Guide.

Figure A-4. Schematics of CapSense Circuit

CapSense Button CMOD, CSH & CINT
Optlonal CSH
CSB1 CINTA
C26 047nF( > 087 047nF
> P7_1 P7_2
SPCAP_BUTO_P8_1 sV < < 50V
Button 1 C77 ||2.2nF _ /v C88 || 10nF
|—< > P7_7 P7_3 ( >—”—
<CAP_TX_P1_0 sov < < Sov
" CMOD CSH
CSB2 No Load
N
SYCAP_BUT1_P8_2
Button 2
CapSense Shield
CapSense Slider No Load
P6_3 (p—RI A A Q0hm CAP_SH1
N No Load
AP_SEGO_P8_3
»C P13.6 (> BIIL A A Sohm _JSHIELD 1
. SPCAP_SEG1_P8_4
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>YCAP_SEG3_P8_6
SPCAP_SEG4_P8_7
|—<<>>CAP TX_P1_0
CapSense Proximity
J13
SSCAP_PROX_P8_0
CON 2x1
A.2.8 LEDs

LED1, LED2, and LED3 (Red, Amber, and Green respectively) indicate the status of the KitProg2
(See the KitProg2 User Guide for details). LED4 (amber LED) indicates the status of power supplied
to PSoC 6 MCU. LED7 (Green) indicates the status of power delivery output on J16. LED6 (Red)
indicates the battery charger status.

The Pioneer board also has two user controllable LEDs (LED8 and LED9) and an RGB LED (LED5)
connected to PSoC 6 MCU pins for user applications.
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A.29 Push Buttons

The PSoC 6 BLE Pioneer Kit has a reset button and three user buttons. The reset button (SW1) is
connected to the XRES pin of the PSoC 6 MCU, and is used to reset the device. One user button
(SW2) is connected to pin PO[4] of the PSoC 6 MCU. The remaining two buttons - SW3 and SW4 are
connected to the PSoC 5LP device for programming mode and custom app selection respectively
(Refer to the KitProg2 User Guide for details). All the buttons connect to ground on activation (active
low) by default. User button (SW2) can be changed to active high mode by changing the zero resis-
tors shown below.

User Button /
Hibernate Wakeup

voDD voDD
R145 R149
10K > Oohm
No Load N No Load
P0_4<K; o0
SW2
R148 EVQ-PE105K R150
10K Oohm
No Load >

-

A.2.10 Cypress NOR Flash

The Pioneer board has a Cypress NOR flash memory (S25FL512SAGMFI011) of 512 Mb capacity.
The NOR Flash is connected to the serial memory interface (SMIF) of PSoC 6 MCU. The NOR
device can be used for both data and code memory with execute-in-place (XIP) support and encryp-
tion.
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A.3 PSoC 6 BLE Pioneer Board Reworks

A.3.1 Bypassing protection circuit on PSoC 6 MCU Program and Debug Header (J11)

The 10-pin header allows you to program and debug PSoC 6 MCU using an external programmer
such as MiniProg3. This header has a protection circuit that cuts-off any voltage greater that 3.4 V on
VTARG_REF pin. This is to ensure that PSoC 6 MCU and other 3.3 V devices do not get damaged
due to overvoltage.

Program/Debug Overvoltage Protection

P6_VDD VTARG_REF
R152 Oohm

No Load
3 2 ) 2 3

ol
DMP3098L-7
NTR4171PT1G R151 -
~ 15K <
Q

5
PMV48XP,215 1

o~

D9

Target PSoC Program/Debug Header
VTARG_REF

1

| 2__sstws_swpio

1 ;
3 A
g )TCLK_SWCLK
c133 Tvs4 ‘><¥B‘ofswo
;;\F[ ESD3V3D5-TP 0 KSWD_RST L
HDR_S 5x2

In case the external programmer provides slightly higher voltage, say 3.42 V, and you need to still
use the programmer, you can bypass this protection circuit by populating the bypass zero-ohm resis-
tor R152.

Do note that this change will compromise the protection circuit when an external supply is used and
will permanently damage any 3.3 V device if the external voltage exceeds absolute maximum limit of
devices. For example, 3.6 V for PSoC 6 MCU device, see the respective device datasheet for abso-
lute maximum voltage limits.

oO~Nawa |S
SomaN

BZT52C3V9-7-F
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A.3.2 PSoC 6 MCU User Button (SW2)

By default, this button connects the PSoC 6 MCU pin to ground when pressed, and you need to con-
figure the PSoC 6 MCU pin as a digital input with resistive pull-up for detecting the button press. In
case you need to sense active HIGH on PSoC 6 MCU pin, resistor R150 should be removed and
R149 should be populated. This will connect the button connecting the PSoC 6 MCU pin to Vppp
when pressed. Additionally, there are footprints provided for pull-up and pull-down resistors that can
be populated in case external pull-up is required.

User Button /
Hibernate Wakeup

vVDDD vVDDD

SW2
R148 % EVQ-PE105K R150

< L

A.3.3 CapSense Shield

The hatched pattern around the CapSense buttons and slider are connected to ground. In case lig-
uid tolerance is required, this pattern needs to be connected to shield pin. This pattern can be con-
nected to either of the two ports P6.3 or P13.6 populated by R138 or R137, respectively. In both
cases, resistor R144 connecting the hatched pattern to ground needs to be removed. These pins
need to be configured as shield pin in PSoC creator.

Connecting the hatched pattern to shield instead of ground will also reduce parasitic capacitance of
the sensors.

CapSense Shield

No Load
P6_3 ((O>—RI38 \ A Sohm CAP_SH1
No Load

P13_6 <<> R137/\/\Oohm

SHIELD 1

R144 Oohm

N\
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A34 CSH

The shield tank capacitor (CSH) is not populated by default. This capacitor is optional, and can be
used for an improved shield electrode driver when CSD sensing is used. You can remove R88 to dis-
connect port 7.3 from header and populate C88 (10nF) for CSH. See the bill of material (BOM) for
recommended part number.

CMOD, CSH & CINT

Optional CSH
CINTA CINTB

C26 | |0.47nF (5>—C81 | 0.47nF
5oV > P71 P72 K Sov
4 Cr7|[22nF (5>—C88 | [10nF
&5V > P7_7 P7_3 L) 50V

CMoD CSH
No Load

A4

A.3.5 U.FL

This connector can be used for conductive measurements and can also be used to connect external
antenna. This is not loaded by default. Remove L1, C1, populate L2, C4 and populate the U.FL con-
nector (J17) to connect ANT pin from PSoC 6 MCU to connector. See the BOM for recommended
part numbers.

1
U1A Wiggle Antenna
C2 K1
PO.0 ANT s s L1 ~~~A~InH, - ~
—E4 | P01 D10 c1
TE3|PO2 P9.0 'pg— 1.2pF
—F3|PO3 P9.1 ' pg— ce 50V
—pz| P0.4 P9.2 D7 — TpF
P0.5 P9.3 [TT0— 50V
G3 P9.4 o —
—Fz ] P1.0 P9.5 'te—
—J5 1 P1.1 P9.6 FT7 — 17
—J7{ P1.2 P9.7 / 2
J3| P1.3 B8 L2 inH, 1
—J7 | P14 P10.0 A8 — No Load 3
P1.5 P10.1 [FF5—
L6 P10.2 [ E5— R =
5.0 P103 1_‘;pF U.FL-R-SMT-1(10)
—J5] P5.1 P10.4 [FB7— 50V
—K7] P52 P10.5 A7 — No Load
—J7{ P5.3 P10.6 ——
— 18 | P54
—WMg | P5.5 F5
—1 P56 P11.0 [ E5—
P11.1 D5 —
on D14 5 bem—
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A.3.6 LiPo Battery Charger

Battery connector (J15) for lithium-ion polymer battery charger is not loaded by default, this need to
populate to evaluate battery charging and battery powering option. See the BOM for recommended
part numbers. Recommended lithium-ion polymer rate is 3.7 V @850 mAH or higher. SparkFun Elec-
tronics PRT-13854 or equivalent. batteries can be used

LiPo Battery Charger

P14
VCC 5V RED u14 VBAT_PP
T No Load 18 o L6
9 N w 15|
274 c12 N sw ‘ cio | car
. Cc42 OuF 220F
25V u
26.7K PMID R 1uF 10v 25v
% BOOT 25V
SYS 5]
VDPM sYs
1
_ BGATE [——x VBAT
CE 8 cé6
17 BAT g { 1uF
1USB1 1USB1 BAT 25v
1USB2 1USB2
1USB3 1USB3 5
12 TS ——<K TS Battery Connector
R80 4020hm \SET
1% VDRV VBAT
21 J15
77-{ PGND 3 cag 1
20| PGND DRV o
EPAD | AGND _PG [F3—X Tov
EPAD CHG « cHeL HDR_S 2x1_R/A
N BQ24266RGER Noload

A.3.7 Multiplexed GPIOs

Some of the PSoC 6 MCU pins are multiplexed with onboard peripherals and are not connected to
connectors or other secondary components by default. See the PSoC 6 pin mapping table for details
on modification required to access these pins.
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A4 Bill of Materials

Refer to the BOM files in the following paths in the kit software installed:

1.

<Install Directory>\CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit\1.0\
Hardware\CY8CKIT-062-BLE\CY8CKIT-062-BLE PCBA BOM.xlsx

. <Install Directory>\CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit\1.0\

Hardware\CY8CKIT-028-EPD\CY8CKIT-028-EPD PCBA BOM.xlsx

A.5 Frequently Asked Questions

»w

= © ©® N o O

18.

19.
20.
21.
22.
23.
24.

25

. I don’t have a Type- C connector on my PC. Can | still connect and use this kit?

How does CY8CKIT-062-BLE handle voltage connection when both multiple power sources are
plugged in?

How can | access Smart I/O and other GPIOs connected to onboard peripherals?

Why does the Red LED of RGB LED (LEDS) light up when switch SW7 is set to SuperCap posi-
tion?

What can | use the U.FL connector for and what is the typical mating cycle for these connectors?
What are the three selection switches on baseboard for?

What is the Jumper onboard for?

What are the input voltage tolerances? Are there any overvoltage protection on this kit?

Why is the voltage of the kit restricted to 3.3 V? Can'’t it drive external 5 V interfaces?

. By mistake, | powered my Arduino board while powering PSoC 6 MCU. Is my PSoC 6 chip alive?

. What type of battery can | use for this kit?
12.
13.
14.
15.
16.
17.

By mistake, | connected the battery with opposite polarity. Did | fry the system?

Can | charge any kind of Type-C device using this kit?

How can | evaluate the USB Type-C provider and consumer features to get started with?
Why is the screen of EPD permanently ON?

Why does the screen of EPD glitch from black to white during every transition?

When | touch the resistors near the CapSense slider/button, the EPD Shield and LED are trig-
gered. Why does this happen?

The EPD shield shows white and black lines after | switched OFF the kit. Is the EPD shield dam-
aged?

| am unable to program the target device.

Does the kit get powered when | power the kit from another Cypress Kit through the J1 header?
What additional overlays can be used with the CapSense?

What is PMOD?

With what type of shield from Cypress can | use this baseboard?

Can | use this Kit as a programmer to program external PSoC devices?

. Which third-party debuggers does this Kit support?
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1.

| don’t have a Type- C connector on my PC. Can | still connect and use this kit?

Yes. To evaluate PSoC 6 MCU features, any PC with USB2.0 connectivity is sufficient. Type-C
power adapter is required only to evaluate the CCG3 section of the Kit.

How does CY8CKIT-062-BLE handle voltage connection when both multiple power sources are
plugged in?

There are five different options to power the baseboard; Type-C USB connector (J10), External
DC supply via VIN connector (J9/ J1), Debug and trace header (J12, VTARG_IN), Program and
debug header (J11), and LiPo battery header (J15). Both Type-C and VIN take priority over other
supply options. These inputs are ORed using diode and the higher voltage among the two take
precedence. Output of ORing diode is given to a buck-boost regulator (U16) that generate a con-
stant 5.2 V. This output is ORed with ETM supply (J12) which is typically 5 V. For most of the
practical uses, output from the 5.2 V regulator takes priority and the same is given as an input to
Cypress buck regulator (U6). LiPo battery voltage is used when all the above sources are absent.
Output of Cypress buck regulator (U6) is ORed with supply voltage from the Program and debug
header (J11), and higher voltage takes precedence. See the Power supply scenarios table for
more details on voltage input and output scenarios.

How can | access Smart I/O and other GPIOs connected to onboard peripherals?

Some of the Smart I/O (Port 8 and Port 9.3) and GPIO connected to onboard peripherals are mul-
tiplexed with PSoC 6 MCU I/O headers (J18, J19, and J20). By default, some of these 1/Os are
connected to onboard peripherals using series resistors. These resistors can be changed to route
these 1/Os to headers. See Table 1-2 on page 10. Pioneer board Pinout for details on list of resis-
tors that needs to be changed.

. Why does the Red LED of RGB LED (LED5) light up when switch SW7 is set to SuperCap posi-

tion?

This behavior is observed if SuperCap is charged below 1.5 V. The I/Os referring to this domain
will leak current, in this case P0O[3]. VBACKUP feature needs to be enabled in silicon before
switching SW7 to SuperCap position. See the RTM/ datasheet on options to enable SuperCap
charging.

What can | use the U.FL connector for and what is the typical mating cycle for these connectors?

U.FL can be used for conductive measurements and to connect external antenna. U.FL connec-
tors are not designed for reconnection. They are rated only for approximately 30 mating cycles.

What are the three selection switches on baseboard for?

Table 1-1 on page 9 gives details on all three selection switches. Additionally, each code example
documentation explains the selection switch setting required for each code example.
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Appendix

7. What is the Jumper on board for?

The jumper J8 can be used to measure current of PSoC 6 MCU device without the need to desol-
der any component from the board. An ammeter can be connected across this jumper to mea-
sure the current consumed by the PSoC 6 MCU device. Remove the Jumper on J8, connect an
ammeter (+ve terminal of ammeter to Pin 2), and power the kit though USB connector J10.

. What are the input voltage tolerances? Are there any overvoltage protection on this kit?
Input voltage level are as follows:

Table A-2. Input voltage levels

Supply Typical ilp Absolute max )
voltage (overvoltage protection)
USB Type-C connector (J10) 4.5V to 12V 15V
VIN connector (J9/J1) 5V to 12V 15V
Debug and trace header (J12) 5v 5.5V
Program and Debug header (J11) 1.8V to 3.3V 3.6V
Li-Po battery connected (J15) 3.2V to 4.2V 5v

9. Why is the voltage of the kit restricted to 3.3 V? Can’t it drive external 5 V interfaces?

PSoC 6 is not meant to be powered for more than 3.6 V. Powering PSoC 6 to more than 3.3 V will
damage the chip. You cannot drive 1O system with > 3.3 V supply voltages.

10. By mistake, | powered my Arduino board while powering PSoC 6 MCU. Is my PSoC 6 chip alive?

Yes. The 3.3 V and 5 V on Arduino power header are not input pins and have protection circuit to
prevent the voltage from entering the board. VIN is an input pin and this is routed to the regulator
that is capable of taking an absolute maximum of 15 V. P6.Vpp pin is not protected and care

should be taken not to supply voltage to this pin.

11. What type of battery can | use for this kit?

Recommended lithium-ion polymer rating is 3.7 V @850 mAH or higher. SparkFun Electronics
PRT-13854 or equivalent batteries can be used. The LiPo battery charger can charge at 100 mA
or 1.5 mA based on whether the USB connection is a legacy device or PD capable.

12. By mistake, | connected the battery with opposite polarity. Did | fry the system?

There are relevant protection circuits to protect the system from permanent damage. Prolonged
connection may lead to damage.

13. Can | charge any kind of Type-C device using this kit?

Kit is programmed to advertise the VIN voltage with 1 A current rating. 9 V and 12 V devices are
the recommended options. VIN needs to be 9 V and 12 V respectively for this to work.
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14. How can | evaluate the USB Type-C provider and consumer features to get started with?

You can use any kind of Type-C laptop, mobile phone, or PD adapters based on the feature that
you are trying to evaluate. To use as consumer, note that devices like laptop may be able to pro-
vide only 5 V out and may not support 9 V/12 V without a docking station. To use as provider,
any 5 V/9 V/12 V device that has a current requirement of less that 1 A may be used. Addition-
ally, Cypress has its own USB Type-C evaluation Kit which can be used to evaluate the provider
and consumer features and many more. Visit http://www.cypress.com/products/usb-type-c-and-
power-delivery for details on these kits.

15. Why is the screen of EPD permanently ON?

Electronic paper and e-paper are display devices that mimic the appearance of ordinary ink on
paper. Unlike conventional backlit flat panel displays that emit light, electronic paper displays
reflect light like paper. This may make it more comfortable to read and provide a wider viewing
angle than most light-emitting displays. The contrast ratio in electronic displays available as of
2008 approaches newspaper, and newly developed displays are slightly better. An ideal e-paper
display can be read in direct sunlight without the image fading. Many electronic paper technolo-
gies hold static text and images indefinitely without electricity. To know the details, see https://
en.wikipedia.org/wiki/Electronic_paper.

16. Why does the screen of EPD glitch from black to white during every transition?

The screen of EPD shield refreshes at every transition. It first clears all the cells of the display by
spreading it with white pixels and then posts the images.

17.When | touch the resistors near the CapSense slider/button, the EPD Shield and LED are trig-
gered. Why does this happen?

Those are the series limiting resistors which interface CapSense lines with ICs 1/O lines. As you
are touching CapSense lines, it triggers EPD shield which responds to CapSense.

18. The EPD shield shows white and black lines after | switched OFF the kit. Is the EPD shield dam-
aged?
EPD retains the image when you may have powered OFF the kit. In case the kit is powered OFF
during transition between images, lines might appear.

19. I am unable to program the target device.
a. Check SW6 to ensure it is in PSoC 6 MCU position.
b. Make sure that no external devices are connected to J11.

c. Update your KitProg2 Version in programmer to 1.04 or later using the steps mentioned in Kit-
Prog2 User Guide.

d. Ensure that device used in PSoC Creator is CY8C6347BZ|-BLD53

20. Does the kit get powered when | power the kit from another Cypress Kit through the J1 header?
Yes, VIN pin on J1 header is the supply input/output pin and can take up to 12 V.

PSoC® 6 BLE Pioneer Kit Guide, Doc. # 002-17040 Rev. *B 57


http://www.cypress.com/products/usb-type-c-and-power-delivery
http://www.cypress.com/products/usb-type-c-and-power-delivery

& CYPRESS

N EMBEDDED IN TOMORROW™

21. What additional overlays can be used with the CapSense?

Any kind of overlays (up to 5 mm thickness) like wood, acrylic, and glass can be used with this
CapSense. Note that additional tuning may be required when the overlay is changed.

22. What is PMOD?

PMOD interface or Peripheral Module interface is an open standard defined by Digilent Inc in the
Digilent Pmod Interface Specification for peripherals used with FPGAs or microcontrollers. Sev-
eral types of modules are available from simple push buttons to more complex modules with net-
work interfaces, analog to digital converters or LCD displays. PMODs are available from multiple
vendors such as Diligent, Maxim Integrated, Analog Devices and a variety of hobby sites. This
Kit supports only 1 x 6 pin PMOD modules.

23. With what type of shield from Cypress can | use this baseboard?

Any Arduino Uno shield which supports 3.3 V operation is compatible with this Pioneer board.
Following cypress shields are pin compatible with this pioneer board:

CY3280-MBR3
CY8CKIT-022
CYB8CKIT-024
CYB8CKIT-026
CYB8CKIT-040
CYB8CKIT-046
CYB8CKIT-048

@ "0 a0 T o

24. Can | use this Kit as a programmer to program external PSoC devices?

Yes, the onboard KitProg2 can program any PSoC 4/5/6 devices connected to J11 header.
Switch SW6 should be switched to “External Device” position to program devices connected via
J11 header.

25. Which third-party debuggers does this Kit support?

Multiple third-party IDEs are supported; IAR and uVision are some examples. For more details
on all supported devices and procedures to export to these IDEs, see PSoC Creator ‘Help’
menu.
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